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REMOTE CONTROL

Remote control (CI-V) information

< CI-V connection

The transceiver’s operating frequency, mode, VFO and memory selection, can be remotely controlled using a PC.

The lcom Communications Interface V (CI-V) controls the transceiver.

Connect the transceiver to a PC with a USB cable (User supplied).

® Make the connection as short as possible. The transceiver may not be recognized by the PC, depending on the
USB cable length.

® When connecting to a USB port on your PC with the USB driver installed, USB (A) and USB (B) are named as
“IC-905 Serial Port A (CI-V)” and “IC-905 Serial Port B.”

® The values that can be set with each command differ, depending on the transceiver version.
See the transceiver’s instruction manual for details.

Right side panel To use the USB cable between the transceiver and a
PC, you must first install a USB driver.

The latest USB driver and installation guide can be
downloaded from the lcom website.

USB cable
(User supplied)

PC l
g R [ =

To a USB port To the [USB] port

Carefully read the guide, before installing the driver.
https://www.icomjapan.com/support/

< Preparing

The Icom Communications Interface V (CI-V) is used for remote control.

To control the transceiver, first set its address, data communication speed, and transceive function.
These settings are set in the Set mode (Refer to the IC-905 Basic manual).

< About the data format
The CI-V system can be written using the following data formats. Data formats differ according to command
numbers. A data area or sub command is added for some commands.

Controller (PC) to IC-905 OK message to controller (PC)
@® @ ® ® ©® ® @
|FE|FE| AC| E0 | Cn | Sc | Data area | FD | |FE|FE| EO | AC| FB | FD|
T ,_T T o=
52 3% 55 ‘ §§
= —”’ﬁ w§ £2 gg w52 §~ = w§ -"’§ X f;'f’,\
28 EL s S c (= "('U'EE U;g 28 L E,_ @} (”g
¢ 235 83 28 =m& SES 22 8% 83 =3 8 %
EE 88 ©o& T S © 05 & EE TS 8a &
T @ e E= Cc£5§ Eg o %28 [ S o Ex Q= [
o] cSs &5 ©3 8 89¢€ 5o 05 cS £33 5o
a3 885 88 Eg §p §5 © 8 o8 8§ £&§ 8 o8
=D © E££ 8<£ ase c o Fo 3 c
ke T Qo Qo Ogo w © kel 85 W
Oo S0 oo ?
% 8 38 £ Ok
l l l |
|FE|FE| EO | AC | Cn | Sc | Data area | FD | |FE|FE| EO | AC | FA | FD|
® @ ® @ ©® ® @
IC-905 to controller (PC) NG message to controller (PC)




REMOTE CONTROL

Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. Data Description Cmd. [ Sub cmd. Data Description
00 See p. 16. Send the frequency data OE B0*2 Clear the Select channel setting
(transceive) B1*2 Set as select channel
01 See p. 16. Send the mode data (transceive) ® The previously set number by
02*1 See p. 16. Read the band edge frequencies Cl-Vis set after turning power
031 S 16 Read th ting f ON, or “1” is selected if no
; ee p. 10. ead the opera !ng requency selection is performed.
04 See p. 16. Read the operating mode 01~03 Set the channel as a Select channel
05*2 See p. 16. Set the operating frequency (01=SEL1, 02=SEL2, 03=SEL3)
06*2 See p. 16. Set the operating mode B2*2 00 ~ 03 Set the Select memory scan
07 Select the VFO mode channel
00 Select VFO A (00=ALL, 01=SEL1, 02=SEL2,
03=SEL3)
01 Select VFO B
- DO*? Set Scan resume OFF
A0 Equalize VFO Aand VFO B "
® When the split frequency D3 Set Scan resume ON (Close&Delay)
operation is OFF in the Memory OF 00*! Read Split OFF setting
mode or the Call channel mode, 01*1 Read Split ON setting
FA” (NG) is retumed. 11+ Read DUP- operation
BO Exchange VFO A and VFO B. 191 Read DUP+ operation
® When the split frequency ” -
operation is OFF in the Memory 13 Read DD Repeater Simplex mode
mode or the Call channel mode, (RPS)
“FA” (NG) is returned. 00*2 Set Split function OFF
08*2 Select the Memory mode 01*2 Set Split function ON
0000 ~ 0099 [Select the Memory channel 10*2 Set the simplex operation
(Memory channel: 0000 ~ 0099 11*2 Set DUP- operation
Call channel: 0000 (144C1), 2 -
0001 (144C2), 12 Set DUP+ operation
0002 (430C1), 13*2 Set DD Repeater Simplex mode
0003 (430C2), (RPS)
0004 (1200C1), 10* 00~ 12 Send/read the tuning step
0005 (1200C2), (00=0OFF (10Hz or 1Hz)
0006 (2400C1), 01=100Hz, 02=500Hz,
0007 (2400C2), 03=1kHz, 04=5kHz,
0008 (5600C1), 05=6.25kHz, 06=10kHz,
0009 (5600C2), 07=12.5kHz, 08=20kHz,
0010 (10GC1), 09=25kHz, 10=50kHz,
0011 (10GC2) 11=100kHz, = 12=250kHz)
A0 0000 ~ 0100 |Select the Memory group 11* 00 Send/read attenuator OFF setting
(Memory channel group: 10 Send/read 10 dB attenuator setting
0000 ~ 0099 ® You can set in the 144/430/1200
Call channel group: 0100) MHz bands.
09 Memory write 13 00 Speech all data by voice synthesizer
0A Memory copy to VFO (S meter level, frequency, and mode)
0B Memory clear 01 Speech the operating frequency and
0C*! See p. 17. Read frequency offset S meter level by voice synthesizer
0D*2 See p. 17. Send frequency offset 02 Speech the operating mode by voice
synthesizer
OB 00 Cancel the scan ® The mode is announced after the
01 Start a Programmed/memory scan ongoing speech.
02 Start a Programmed scan 14* |01 0000 ~ 0255 |Send/read the AF level
03 Start a 4F scan (0000=Minimum ~ 0255=Maximum)
12 Start a Fine programmed scan 02 0000 ~ 0255 |Send/read the RF gain level
13 Start a Fine AF scan (0000=Minimum ~ 0255=Maximum)
22 Start a Memory scan 03 0000 ~ 0255 |Send/read the squelch level
(0000=Minimum ~ 0255=Maximum)
23 Start a Select memory scan
24 Start a Mode Select 06 0000 ~ 0255 |Send/read the NR level
- art a Vlode select scan (0000=0% ~ 0255=100%)
AX Select AF scan span 07 0000 ~ 0255 | Send/read [TWIN PBT] (PBT1) position
x=1~7) (x=1 (#5kHz), x=2 (+10kHz), (0000=max. Counter Clockwise ~
X=3 (#20kHz),  x=4 (+50kHz), 0128=center ~ 0255=max. Clockwise)
x=5 (+100kHz), x=6 (+500kHz),
=7 (£1MHz))




REMOTE CONTROL

Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. Data Description Cmd.| Sub cmd. Data Description
14* (08 0000 ~ 0255 |Send/read [TWIN PBT] (PBT2) 16* (12 01~03 Send/read the AGC time constant
position (01=FAST, 02=MID, 03=SLOW)
(0000=max. Counter Clockwise ~ 22 00/01 Send/read the Noise blanker
0128=center ~ 0255=max. Clockwise) (00=OFF, 01=ON)
09 0000 ~ 0255 | Send/read CW pitch (5 Hz steps) 40 00/01 Send/read the Noise reduction
(0000=300 Hz ~ 0128=600 Hz ~ (OOZOFF, 01 :ON)
02852900 Hz) 41 00/01 Send/read the Auto Notch function
0A 0000 ~ 0255 |Send/read the selected band’s RF (00=OFF, 01=ON)
power
(0000=Minimum ~ 0255=Maximum) 42 00/01 (Soeon_dcl)rsl";‘dotrfoRﬁ)peater tone
0B 0000 ~ 0255 |Send/read MIC gain :
(0000=Minimum ~ 0255=Maximum) 43 00/01 (SO%r‘_dC’)rs?dO‘:‘fgﬁ')‘e squelch
ocC 0000 ~ 0255 |[Send/read keying speed :
(0000=6 WPM ~ 0255=48 WPM) 44 00/01 (Soeorldcl)r'(:a'e:ldot:iaosl\;‘))eech compressor
0D 0000 ~ 0255 |[Send/read Notch filter setting : -
(0000=max. Counter Clockwise ~ 45 00/01 fSenf(i./read the Monitor [MONI]
0128=center ~ 0255=max. Clockwise) (l(J)BE(ISEF 01=ON)
0E 0000~ 0235 | Send/read the COMP level 46 00/01 Send/read the VOX function
(0000=0 ~ 0255=10) (00=OFF, 01=ON)
oF 0000 ~ 0255 (S()%%dér:‘zagéhf :zrgggg g) de)'ay setting 47 00 ~ 02 Send/read the BK-IN function
: - (00=BK-IN OFF, 01=Semi BK-IN ON,
12 0000 ~ 0255 |Send/read NB level 02=Full BK-IN ON)
=09 ~ — 0,
(0000=0% ~ 0255=100%) 48 00/01 Send/read the Manual Notch function
15 0000 ~ 0255 |[Send/read Monitor audio [MONI] level (00=OFF, 01=ON)
=09 ~ — 0,
(0000=0% ~ 0255=100%) 4A 00/01 Send/read the AFC function
16 0000 ~ 0255 |Send/read the VOX gain (00=OFF, 01=ON)
=09 ~ — 0,
(0000=0% ~ 0255=100%) 4B 00/01 Send/read the DTCS function
17 0000 ~ 0255 |Send/read the Anti VOX gain (00=OFF 01 =ON)
=09 ~ — 0,
(0000=0% ~ 0255=100%) 4F 00/01 Send/read the Twin peak filter
19 0000 ~ 0255 |Send/read LCD backlight brightness (00=OFF, 01=ON)
(0000=0% ~ 0255=100%) (Can be turned ON only when Mark
15*7 (01 00/01 Read noise or S-meter squelch status and Shift are set to 2125 Hz and
(00=Close, 01=0Open) 170 Hz, respectively)
02 0000 ~ 0255 |Read S-meter level 50 00/01 Send/read the Dial Lock function
(0000=S0, 0120=S9, (00=0FF, 01=0ON)
0241=59+60 dB) 56 00/01 Send/read DSP IF filter type in the
05 00/01 Read various squelch (tone squelch, operating band
and so on) status (00=SHARP, 01=SOFT)
(00=Close, 01=Open) 57 00 ~ 02 Send/read the Manual Notch width
07 00/01 Read the OVF status (00=WIDE, 01=MID, 02=NAR)
(00=OVF indicator is OFF, 58 00 ~ 02 Send/read SSB transmit bandwidth
01=0VF indicator is ON) (00=WIDE, 01=MID, 02=NAR)
11 0000 ~ 0255 |Read the Po meter level (One of following values is applied,
(0000=0% ~ 0143=50% ~ depending on the “COMP” status
0213=100%) (ON or OFF):
12 0000 ~ 0255 |Read SWR meter level WIDE (Command: 1A 05 0017),
(0000=SWR1 _0’ 0048=SWR15, MID (Command: 1A 05 0018), or
0080=SWR2.0, 0120=SWR3.0) NAR (Command: 1A 05 0019))
13 0000 ~ 0255 |Read ALC meter level 5B 00 ~ 02 Sfend/read the DSQL (Qigital Call
(0000=Minimum ~ 0120=Maximum) Slgn ISC}]1ue|C::l)/CSQL (Dlglta| Code
14 0000 ~ 0255 |Read COMP meter level (sgtj/err(:oé:eor:lr;g
(0000=0 dB ~ 0130=15dB ~ _ _ _
15%8 0000 ~ 0255 |Read Vo meter level (00~OFF erma oo A
(0000=0 V ~ 0040=5 V ~ 0241=30 V) =5 00~ 03 Send) ,dth T S oh funct
16 0000 ~ 0255 |Read Ip meter level : enareac "ne one Squeich lunction
06 ~ 09 (00=0FF, 01=TONE, 02=TSAQL,
(0000=0 A~ 0121=2 A~ 0241=4 A) 03=DTCS, 06=DTCS (T)
16* |02 00/01 Send/read the Preamp 07=TONEY(T)/DTCS (R),‘
(00=OFF, 01=0ON) 08=DTCS (T)/TSQL (R),

09=TONE (T)/'TSQL (R))
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Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. Data Description Cmd.| Sub cmd. Data Description
17*3 See p. 17. Send CW messages 1A* |05 |SET > Tone Control/TBW
18 00 Turn OFF the transceiver 0018 |00~ 10 TX > SSB >
01*4 Turn ON the transceiver Send/read TX Tone (Treble) level
19*1 |00 Read the transceiver ID 0019 (00=-5 ~ 10=+5)
. See p. 20. TX > SSB >
1A 00 ::g 1pg 18 Send/read memory contents Send/read TX bandwidth for wide
- : 0020 |See p. 20. TX > SSB >
01 See p. 19. Send/read band stacking register Send/read TX bandwidth for mid
contents
0021 |See p. 20. TX > SSB >
*5
02 See p. 20. Send/read memory keyer c.ontent.s Send/read TX bandwidth for narrow
03 See p. 20. Send/read the selected IF filter width 0022 |See p. 20. TX > SSB.D >
04 See p. 20. Send/read the selected AGC time Send/read TX bandwidth
constant 0023 [00~10 X >AM >
05 |SET > Tone Control/TBW Send/read TX Tone (Bass) level
0001 |See p. 20. RX > SSB > (00=-5 ~ 10=+5)
Send/read RX HPF/LPF settings 0024 |00~ 10 TX > AM >
0002 |00~ 10 RX > SSB > Send/read TX Tone (Treble) level
Send/read RX Tone (Bass) level (00=-5 ~ 10=+5)
(00=-5 ~ 10=+5) 0025 |00~ 10 TX>FM >
0003 |00~ 10 RX > SSB > Send/read TX Tone (Bass) level
Send/read RX Tone (Treble) level (00=-5 ~ 10=+5)
(00=-5 ~ 10=+5) 0026 |00~ 10 TX>FM >
0004 |See p. 20. RX > AM > Send/read TX Tone (Treble) level
Send/read RX HPF/LPF settings (00=-5 ~ 10=+5)
0005 |00~ 10 RX > AM > 0027 |00~ 10 TX>DV >
Send/read RX Tone (Bass) level Send/read TX Tone (Bass) level
(00=-5 ~ 10=+5) (00=-5 ~ 10=+5)
0006 |00~ 10 RX >AM > 0028 |00~ 10 TX>DV >
Send/read RX Tone (Treble) level Send/read TX Tone (Treble) level
(00=-5 ~ 10=+5) (00=-5 ~ 10=+5)
0007 |See p. 20. RX >FM > 0029 |00~ 10 TX > ATV >
Send/read RX HPF/LPF settings Send/read TX Tone (Bass) level
0008 |00 ~10 RX > FM > (00=-5 ~ 10=+5)
Send/read RX Tone (Bass) level 0030 |00~10 TX>ATV >
(00==5 ~ 10=+5) Send/read TX Tone (Treble) level
0009 |00~ 10 RX > FM > (00=-5 ~ 10=+5)
Send/read RX Tone (Treble) level SET > Function
(00=-5 ~ 10=+5) 0031 |0000 ~ 0255 |Send/read the Beep Level setting
0010 |See p. 20. RX > DV > (0000=Minimum ~ 0255=Maximum)
Send/read RX HPF/LPF settings 0032 {00/01 Send/read the Beep Level Limit
0011 |00~ 10 RX>DV > setting
Send/read RX Tone (Bass) level (00=0OFF, 01=0N)
(00=-5 ~ 10=+5) 0033 {00/01 Send/read the Beep (Confirmation)
0012 |00~ 10 RX>DV > setting
Send/read RX Tone (Treble) level (00=0OFF, 01=0ON)
(00=-5 ~ 10=+5) 0034 |00/01 Send/read the Home CH Beep
0013 |00~ 10 RX > AM > setting
Send/read RX Tone (Bass) level (00=OFF, 01=0ON)
(00=-5 ~ 10=+5) 0035 |00 ~ 03 Send/read the Band Edge Beep
0014 [00~10 RX > AM > setting
Send/read RX Tone (Treble) level (00=0OFF, 01=ON (Default),
(00=-5 ~ 10=+5) 02=ON (User),
0015 |[See p. 20. RX > CW > 03=ON (User) & TX lelt)
Send/read RX HPF/LPF settings 0036 |00/01 Send/read the FM/DV Center Error
0016 |Seep.20. |RX>RTTY> setting
Send/read RX HPF/LPF settings (00=OFF, 01=ON)
0017 |00~ 10 TX>88B > 0037 |00 ~ 04 Seqd/read the Auto Power OFF
Send/read TX Tone (Bass) level setting . .
(00=_5 ~ 10=+5) (00=OFF,01=30 min, 02=60 min,
03=90 min, 04=120 min)
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Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. | Data Description Cmd. | Sub cmd. Data Description
1A* |05 |SET > Function 1A* |05 |SET > Function
0038 |00 ~05 Send/read the TX Delay (144M) 0055 |00/01 SPEECH >
setting Send/read the Alphabet setting
(00=0OFF, 01=10 ms, 02=15 ms, (00=Normal, 01=Phonetic Code)
03=20 ms, 04=25 ms, 05=30 ms) 0056 |00/01 SPEECH >
0039 |00~ 05 Send/read the TX Delay (430M) Send/read the SPEECH Speed setting
setting (00=Slow, 01=Fast)
(00=OFF, 01=10 ms, 02=15 ms, 0057 |00 ~02 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the RX Call Sign
0040 |00~ 05 Send/read the TX Delay (1200M) SPEECH setting
setting (00=0FF, 01=0ON (Kerchunk),
(00=0FF, 01=10 ms, 02=15 ms, 02=0N (All))
03=20 ms, 04=25 ms, 05=30 ms) 0058 |00/01 SPEECH >
0041 |00~ 05 Send/read the TX Delay (2400M) Send/read the RX>CS SPEECH setting
setting (00=0FF, 01=0ON)
(00=OFF, 01=10 ms, 02=15 ms, 0059 |[00/01 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the MIC Up/Down
0042 |00~ 05 Send/read the TX Delay (5600M) SPEECH setting
setting (00=0FF, 01=0ON)
(00=OFF, 01=10 ms, 02=15 ms, 0060 |00/01 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the S-Level SPEECH setting
0043 |00~ 05 Send/read the TX Delay (10G) (00=OFF, 01=0ON)
setting 0061 |00/01 SPEECH >
(00=OFF, 01=10 ms, 02=15 ms, Send/read the MODE SPEECH setting
03=20 ms, 04=25 ms, 05=30 ms) (00=OFF, 01=0ON)
0044 |00~ 05 Send/read the Time-Out Timer 0062 |0000 ~ 0255 |SPEECH >
setting Send/read the SPEECH Level setting
(00=OFF, 01=3 min, 02=5 min, (0000=0% ~ 0255=100%)
03=10 min, 04=20 min, 05=30 min) 0063 |00/01 Sendiread the [SPEECH/LOCK]
0045 |00/01 Send/read the PTT Lock setting Switch setting
(00=0FF, 01=0ON) (00=SPEECH/LOCK,
0046 |00/01 SPLIT > 01=LOCK/SPEECH)
Send/read the Quick SPLIT setting 0064 |00/01 Send/read the Lock Function setting
(00=0OFF, 01=0N) (00=MAIN DIAL, 01=PANEL)
0047 |Seep.20. |SPLIT> 0065 |00/01 Send/read the Memo Pad Quantity
Send/read the SPLIT Offset setting setting
0048 |00/01 SPLIT > (00=5 ch, 01=10 ch)
Send/read the SPLIT LOCK setting 0066 |00/01 Send/read the Function of Touch for
(00=OFF, 01=ON) 1 sec MHz Digits setting
0049 |00/01 Send/read the Auto Repeater setting (00=Band Stacking Register,
(00=0FF, 01=ON (DUP), 01=1 MHz Step Tuning)
02=ON (DUP,TONE)) 0067 |00 ~ 02 Send/read the MAIN DIAL Auto TS
0050 |00~ 02 Send/read the RTTY Mark setting
Frequency setting (00=0FF, 01=Low, 02=High)
(00=1275 Hz, 01=1615 Hz, 0068 |00/01 Send/read the MIC Up/Down Speed
02=2125 Hz) setting
0051 |00~ 02 Send/read the RTTY Shift Width (00=Slow, 01=Fast)
setting 0069 |00/01 Send/read the AFC Limit setting
(00=170 Hz, 01=200 Hz, 02=425 HZ) (00=OFF 01=ON)
0052 |00/01 Send/read the RTTY Keying Polarity 0070 |00 ~02 Send/read the [NOTCH] Switch
setting (SSB) setting
(00=Normal, 01=Reverse) (00=Auto, 01=Manual, 02=Auto/Manual)
0053 100~03 Send/read the ATV Audio Sub 0071 |00~ 02 Send/read the [NOTCH] Switch
Carrier Frequency setting (AM) setting
(gg=§gFM?_|1 =‘é—35 '\é”;ZMH (00=Auto, 01=Manual, 02=Auto/Manual)
=6.0 MHz, 03=6.5 MHz) 0072 |00/01 Send/read the SSB/CW
0054 100/01 SPEECH > Synchronous Tuning setting
Send/read the SPEECH Language (00=OFF, 01=ON)
setting - .
_ - ) 0073 |00/01 Send/read the CW Normal Side setting
(00=Japanese, 01=English) (00=LSB, 01=USB)




REMOTE CONTROL

Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. | Data Description Cmd. | Sub cmd. Data Description
1A* |05 |SET > Function 1A* |05 |SET > DV/DD
0074 |00/01 Send/read the Power OFF Setting 0096 |00~ 02 Send/read the Auto Reply setting
(for Remote Control) setting (00=OFF, 01=0N, 02=Voice)
(00=Shutdown only, 0097 |00/01 Send/read the DV Data TX setting
01=Standby/Shutdown) (00=PTT, 01=Auto)
0075 |See p. 22. Front Key CustorTlize > 0098 |00/01 DV Fast Data >
[VOX/BK-IN] setting Send/read the Fast Data setting
0076 |See p. 22. Front Key Customize > (00=0OFF, 01=0ON)
[AUTOTUNE/RX>CS/AFC] setting 0099 [00/01 DV Fast Data >
0077 |See p. 22. Send/read the [A] setting Send/read the GPS Data Speed setting
0078 |See p. 22. Send/read the [B] setting (00=Slow, 01=Fast)
0079 |Seep.22. |Sendfread the [A] setting 0100 |00 ~10 gV Z/ast 5’;:3 ;x Delay (PTT) sett
- end/read the elay setting
0080 |See p. 22. Send/read the [V] setting (00=OFF, 01=1sec ~ 10=10sec)
0081 100/01 gg’é“::tm'; Key > Mode Select > 0101 |00~02 Sendlread the Digital Monitor setting
(00=OFF, O1=0N) 0102 |00/01 (SOO=£uto£;=lglgl.tf I; 22=Anta Io?s) t
0082 |00/01 Remote MIC Key > Mode Select > S:t?inéea ¢ Highial Repeater oe
CW setting
=OFF, 01=ON
(00=OFF, 01=0N) 0103 |00/01 g)o d</) d(:h ?)V)A to Detect setti
0083 |00/01 Remote MIC Key > Mode Select > endiread the LV Aulto Lietect setling
) (00=0OFF, 01=0ON)
RTTY setting
(00=OFF, 01=ON) 0104 |00/01 Send/read the RX Record (RPT) setting
=ALL, 01=L |
0084 |00/01 Remote MIC Key > Mode Select > (00=ALL, 01=Latest Only)
AM setting 0105 |00/01 Send/read the BK setting
(00=OFF, 01=ON) (00=OFF, 01=ON)
0085 |00/01 Remote MIC Key > Mode Select > 0106 |00/01 Send/read the EMR setting
FM setting (00=0FF, 01=0ON)
(00=0OFF, 01=0ON) 0107 |0000 ~ 0255 |Send/read the EMR AF Level setting
0086 |00/01 Remote MIC Key > Mode Select > (0000=0% ~ 0255=100%)
DV setting 0108 |00/01 Send/read the DD TX Inhibit (Power
(00=0FF, 01=0ON) ON) setting
0087 |00/01 Remote MIC Key > Mode Select > (00=0FF, 01=0N)
DD setting 0109 |00/01 Send/read the DD Packet Output
(00=OFF, 01=0ON) setting
0088 |00/01 Remote MIC Key > Mode Select > (00=Normal, 01=All)
ATV setting SET > QSO/RX Log
(00=0OFF, 01=ON) 0110 |00/01 Send/read the QSO Log setting
0089 |00/01 Send/read the Keyboard Type setting (00=OFF, 01=0ON)
(00=Ten-key, 01=Full Keyboard) 0111 |00/01 Send/read the RX History Log setting
0090 |00~ 02 Send/read the Full Keyboard Layout (00=OFF, 01=0ON)
setting 0112 |00~ 02 CSV Format >
(00=English, 01=German, Send/read the Separator/Decimal
02=French) setting
0091 |00/01 Send/read the Screen Capture (00=Separator is “, ” and Decimal is “ . ,”
[POWER] Switch setting 01=Separator is “; " and Decimal is “ . ”
(00=0OFF, 01=0ON) 02=Separator is “; " and Decimal is “, ")
0092 |00/01 Send/read the Screen Capture File 0113 |00 ~ 02 CSV Format >
Type setting Send/read the Date setting
(00=PNG, 01=BMP) (00="yyyy/mm/dd,” 01="mm/dd/yyyy,”
0093 |0000 ~ 0255 |Send/read the REF Adjust setting 02="dd/mm/yyyy")
(0000=0% ~ 0255=100%) SET > Connectors
0094 |0000 ~ 0255 |Send/read the REF Adjust (FINE) 0114 |00/01 Send/read the Speaker MIC AF
setting Output setting
(0000=0% ~ 0255=100%) (00=0FF, 01=0ON)
SET > DV/DD 0115 |00~ 02 Send/read the SP Jack Function setting
0095 |00~ 03 Send/read the Standby Beep setting (00=Speaker, 01=Phone,
(00=OFF, 01=0N, 02=Phone (L+R))
02=ON (to me:High Tone), 0116 |00~ 30 Send/read the Phones Level setting
03=ON (to me:Alarm/High Tone)) (00=-15 ~ 30=+15)
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Sub cmd. Data Description

1A*

05

SET > Connectors

0117 |00/01 USB/AV-OUT AF/IF Output >
Send/read the Output Select setting
(00=AF, 01=IF)

0118 |0000 ~ 0255 |USB/AV-OUT AF/IF Output >
Send/read the AF Output Level
setting
(0000=0% ~ 0255=100%)

0119 |00/01 USB/AV-OUT AF/IF Output >
Send/read the AF SQL setting
(00=OFF (Open), 01=0ON)

0120 |00/01 USB/AV-OUT AF/IF Output >
Send/read the AF Beep/Speech...
Output setting
(00=0OFF, 01=0ON)

0121 |0000 ~ 0255 |USB/AV-OUT AF/IF Output >
Send/read the IF Output Level
setting
(0000=0% ~ 0255=100%)

0122 |00/01 LAN AF/IF Output >
Send/read the Output Select setting
(00=AF, 01=IF)

0123 |00/01 LAN AF/IF Output >
Send/read the AF SQL setting
(00=0OFF (Open), 01=0ON)

0124 |0000 ~ 0255 |MOD Input >
Send/read the USB MOD Level setting
(0000=0% ~ 0255=100%)

0125 |0000 ~ 0255 |MOD Input >
Send/read the LAN MOD Level setting
(0000=0% ~ 0255=100%)

0126 |00~ 03 MOD Input >
Send/read the DATA OFF MOD setting
(00=MIC, 01=USB,

02=MIC, USB, 03=LAN)

0127 |00~ 03 MOD Input >
Send/read the DATA MOD setting
(00=MIC, 01=USB,

02=MIC, USB, 03=LAN)

0128 |0000 ~ 0255 |MOD Input >
Send/read the AV-IN MOD Level
setting
(0000=0% ~ 0255=100%)

0129 |00 ~05 MOD Input >
Send/read the ATV MOD setting
(00=MIC, 01=AV-IN, 02=MIC, AV-IN,

03=USB, 04=MIC, USB, 05=LAN)

0130 |00/01 SEND Output >
Send/read the 144M setting
(00=0FF, 01=0ON)

0131 |00/01 SEND Output >
Send/read the 430M setting
(00=0OFF, 01=0ON)

0132 |00/01 SEND Output >
Send/read the 1200M setting
(00=0FF, 01=0ON)

0133 |00/01 SEND Output >
Send/read the 2400M setting
(00=0FF, 01=0ON)

0134 |00/01 SEND Output >

Send/read the 5600M setting
(00=0FF, 01=0ON)

1A*

05

SET > Connectors

0135 |00/01 SEND Output >
Send/read the 10G setting
(00=0FF, 01=0ON)

0136 |00~ 04 USB SEND/Keying >

Send/read the USB SEND setting

(00=0OFF, 01=USB (A) DTR,

02=USB (A) RTS, 03=USB (B) DTR,

04=USB (B) RTS)

® You cannot select the terminal
which is already selected in the
“USB Keying (CW)” or “USB
Keying (RTTY)” item.

0137 |00~ 04 USB SEND/Keying >

Send/read the USB Keying (CW)

setting

(00=0OFF, 01=USB (A) DTR,

02=USB (A) RTS, 03=USB (B) DTR,

04=USB (B) RTS)

® You cannot select the terminal
which is already selected in the
“USB SEND” item.

0138 |00~ 04 USB SEND/Keying >

Send/read the USB Keying (RTTY)

setting

(00=0OFF, 01=USB (A) DTR,

02=USB (A) RTS, 03=USB (B) DTR,

04=USB (B) RTS)

® You cannot select the terminal
which is already selected in the
“USB SEND” item.

0139 |00/01 External Keypad >
Send/read the VOICE setting
(00=0FF, 01=0ON)

0140 |00/01 External Keypad >
Send/read the KEYER setting
(00=0FF, 01=0ON)

0141 |00/01 External Keypad >
Send/read the RTTY setting
(00=0FF, 01=0ON)

0142 |00/01 Cl-V >
Send/read the CI-V Transceive setting
(00=0FF, 01=0ON)

0143 |00/01 Cl-V >

Send/read the CI-V USB Echo Back
setting

(00=0FF, 01=0ON)

0144 |00~ 03 USB (B) Function >

Send/read the USB (B) Function
setting

(00=0FF, 01=RTTY Decode,
02=DV Data, 03=Weather)

0145 |00/01 USB (B) Function >

Send/read the GPS Out setting

(00=0FF, 01=0ON)

@ ltis valid when “USB (B) Function”
is set to “OFF” or “DV Data.”

0146 |00/01 Send/read the MIC Jack 8V Output
setting
(00=0FF, 01=0ON)

0147 |00/01 Send/read the REF OUT setting

(00=Auto (CX-10G:ON), 01=ON)
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1A* |05 |SET > Display 1A* |05 |SET > Display
0148 |0000 ~ 0255 |Send/read the LCD Backlight setting 0168 |00/01 Display Unit >
(0000=0% ~ 0255=100%) Send/read the Altitude/Distance setting
0149 |00/01 Send/read the LCD Backlight Auto (00=m, 01=ft/mi)
Adjust setting 0169 |00~ 02 Display Unit >
(00=0OFF, 01=0ON) Send/read the Speed setting
0150 |00 ~ 06 Send/read the Screen Saver setting (00=km/h, 01=mph, 02=knots)
(00=0OFF, 01=1min, 02=2min, 0170 |00/01 Display Unit >
03=5min, 04=15min, 05=30min, Send/read the Temperature setting
06=60min) (00="C, 01="F)
0151 |00/01 Send/read the Screen OFF 0171 |00 ~ 03 Display Unit >
[POWER] Switch setting Send/read the Barometric setting
(00=0FF, 01=0ON) (00=hPa, 01=mb, 02=mmHg, 03=inHg)
0152 |00/01 Send/read the Meter Peak Hold setting 0172 |00/01 Display Unit >
(00=OFF, 01=0ON) Send/read the Rainfall setting
0153 |00/01 Send/read the Multi-func. Meter (00=mm, 01=inch)
Voltage Display setting 0173 |00~ 03 Display Unit >
(00=DC IN, 01=VD) Send/read the Wind Speed setting
0154 |00/01 Send/read the Memory Name setting (00=mis, 01=km/h, 02=mph, 03=knots)
(00=OFF, 01=0ON) 0174 |00/01 Send/read the Display Language setting
0155 |00/01 Send/read the Group Name Popup (00=English, 01=Japanese)
setting 0175 |00/01 Send/read the System Language setting
(00=0OFF, 01=0ON) (00=English, 01=Japanese)
0156 |00~ 03 Send/read the RX Call Sign Display SET > Time Set
setting 0176 |20200101 ~ |Date/Time >
(00=0FF, 01=Normal, 20991231 Send/read the Date setting
02=RX Hold, 03=Hold) (20200101=2020/1/1~
0157 |00/01 Send/read the RX Position Indicator 20991231=2099/12/31)
setting 0177 |0000 ~ 2359 |Date/Time >
(00=OFF, 01=ON) Send/read the Time setting
0158 |00/01 Send/read the RX Position Display (0000=00:00 ~ 2359=23:59)
setting 0178 |00/01 Date/Time >
(00=0FF, 01=0N) Send/read the NTP Function setting
0159 |00~ 04 Send/read the RX Position Display (00=0OFF, 01=0ON)
Timer setting 0179 |Seep.19.  |Date/Time >
(00=5sec, 01=10sec, 02=15sec, Send/read the NTP Server Address
03=30sec, 04=Hold) setting
0160 |00/01 Send/read the Reply Position (Up to 64 characters)
Display setting 0180 |00/01 Date/Time >
(00=0FF, 01=0N) Send/read the GPS Time Correct
0161 |00/01 Send/read the RX Picture Indicator setting
setting (00=0OFF, 01=Auto)
(00=OFF, 01=ON) 0181 |Seep.21. |Send/read the UTC Offset setting
0162 |00/01 Send/read the DV RX Backlight setting SET > SD Card
(00=OFF, 01=ON) — 182 |00 ~02 Import/Export > CSV Format >
0163 |00~ 02 Seqd/read the TX Call Sign Display Send/read the Separator/Decimal
setting . setting
(00=0FF, 01=Your Call Sign, (00=Separator is “,” and Decimal is “ . ,”
02=My Call Sign) 01=Separator is “ ; ” and Decimal is “ . ,”
0164 [00/01 Send/read the Scroll Speed setting 02=Separator is “; " and Decimal is “, ")
(00=Slow, 01=Fast) 183 |00 ~ 02 Import/Export > CSV Format >
0165 |00/01 Send/read the Opening Message setting Send/read the Date setting
(00=0OFF, 01=0ON) (00="yyyy/mm/dd,” 01="mm/dd/yyyy,”
0166 |00/01 Send/read the Power ON Check setting 02="dd/mm/yyyy")
(00=0OFF, 01=0ON) SCOPE > SCOPE SET
0167 |00~ 02 Display Unit > 184 | 00/01 Send/read the Scope during Tx
Send/read the Latitude/Longitude (CENTER Type) setting
setting (00=0FF, 01=0ON)
(00=ddd®mm.mnt', 01=ddd"mm'ss", 185 |00 ~ 02 Send/read the Max Hold setting
02=ddd.dddd") (00=OFF, 01=10s Hold, 02=ON)
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1A* |05 |SCOPE > SCOPE SET 1A* |05 |SCOPE > SCOPE SET
0186 |00~ 02 Send/read the CENTER Type 0211 |See p. 21. Fixed Edges > 2400M >
Display setting Send/read the No.1 setting
(00=Fiter Center, 0212 |Seep.21. |Fixed Edges > 2400M >
01=Carrier Point Center, Send/read the No.2 setting
02=Carrier Point Center (Abs. Freq.)) 0213 | See p. 21 Fixed Edges > 2400M >
0187 |00/01 Send/read the Marker Po.sition (FIX o Send/read the No.3 setting
Bgf,ﬁg?g;&tgp;)_sggﬁgr Point) 0214 |Seep. 21. Fixed Edges > 2400M >
0188 |00/01 Send/read th VéW ” Send/read the No.4 setting
(ONamow, O12Wids) 0215 [Seep.21. |Fixed Edges > 5600M >
0189 |00~ 03 Send/read t’h A - " Send/read the No.1 setting
(ODOFF. 0192, 0223, O%ad) 0216 [Seep.21. |Fixed Edges > 5600M >
0190 loo/o1 Sond/ d ” W : ’ T " Send/read the No.2 setting
O0Fh Oty 0217 [Seep.21. |Fixed Edges > 5600M >
o191 Is o Send - 4 the Waveform Col Send/read the No.3 setting
P Cameng sefting 0218 [Seep.21. |Fixed Edges > 5600M >
0192 |s 21 Send/read th \?V form Col Send/read the No.4 setting
SR ey setting. o o 0219 |Seep.21. |Fixed Edges > 10G >
0193 |s 21 Send/read tﬁ Wavef Col Send/read the No.1 setting
SR i Hod) setting 0220 [Seep.21. |Fixed Edges > 10G >
0194 |00/01 Sendiread the W tg tfall Display setti Send/read the No.2 setting
(O0ORF, 010N e 0221 [Seep.21. |Fixed Edges > 10G >
0195 |00~ 02 Sendiread the Waterfal Speed sett Sendiread the Ro.3 sefting
(O0sSiow, 01cMid. 02=Fadt) 0222 [Seep.21. |Fixed Edges > 10G >
0196 100 <02 Send d o W - IS Send/read the No.4 setting
endfread the Waterfall Size AUDIO > AUDIO SCOPE SET
(Expand Screen) setting
(00=Small, 01=Mid, 02=Large) 0223 (00/01 Send/read the FFT Scope
0197 |00~07 Send/read the Waterfall Peak Color Waveform Type setting
Level setting (00=Line, 01=Fill)
(00=Grid1 ~ 07=Grid8) 0224 |Seep. 21. Send/read the FFT Spope
0198 |00/01 Send/read the Waterfall Marker Waveform Color setting
Auto-hide setting 0225 |00/01 S?nd/read the FFT Scope Waterfall
(00=0OFF, 01=0ON) Display setting
0199 |Seep.21. |Fixed Edges > 144M > (00=OFF, 01=ON)
Send/read the No.1 setting 0226 |See p. 21. Send/read the Oscillgscope
0200 |Seep.21. |Fixed Edges > 144M > Waveform Color setting
Send/read the No.2 setting VOICE
0201 |See p. 21. Fixed Edges > 144M > 0227 |0000 ~ 0255 |Send/read the TX LEVEL setting
Send/read the No.3 setting (0000=0% ~ 0255=100%)
0202 |See p. 21. Fixed Edges > 144M > 0228 |00/01 VOICE TX SET >
Send/read the No.4 setting Send/read the Auto Monitor setting
0203 |Seep.21. |Fixed Edges > 430M > (00=OFF, 01=ON)
Send/read the No.1 setting 0229 |01~15 VOICE TX SET > . .
0204 |Seep. 21. Fixed Edges > 430M > Send/read the Repeat Time setting
Send/read the No.2 setting (01=1sec ~ 15=15sec)
0205 |Seep.21. |Fixed Edges > 430M > AsiERe s En il
Send/read the No.3 setting 0230 |00~ 04 Send/read the Number Style setting
0206 |Seep.21. |Fixed Edges > 430M > (gg:’;‘ggmiﬂ B;%%B’ANN%
Send/read the No.4 setting 04:90 _I:IT) P JOTIE
=90—
0207 |Seep.21. |Fixed Edges > 1200M > 0231 |01~08 Send/read the Count Up Trigger settin
Send/read the No.1 setting P ITigg 9
- . (01=M1 ~ 08=M8)
0208 | Seep. 21 gzsg,rii%e;; ,1(2)020 ';"e;ing 0232|0001 ~9999 |Send/read Present Number setting
- 0001=1 ~ 9999=9999
0209 |See p. 21. Fixed Edges > 1200M > KEYER > CW-KEY SE(T )
Send/read the No.3 setting .
0210 |See p. 21 Fixed Edges > 1200M > 0233 |0000 ~ 0255 |Send/read Side Tone Level setting
. . =0% ~ = 9
Send/read the No.4 setting (0000=0% ~ 0255=100%)
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data | Description
1A* |05 |KEYER > CW-KEY SET 1A* |05 |RECORD > Recorder Set
0234 |00/01 Send/read Side Tone Level Limit setting 0256 |00/01 Send/read the PTT Auto REC setting
(00=0OFF, 01=0ON) (00=0OFF, 01=0ON)
0235 |01 ~60 Send/read Keyer Repeat Time setting 0257 |00~ 03 Send/read the PRE-REC for PTT
(01=1sec ~ 60=60sec) Auto REC setting
0236 |28 ~45 Send/read Dot/Dash Ratio setting (00=0OFF, 01=5sec,
(28=1:1:2.8 ~ 45=1:1:4.5 02=10sec, 03=15sec)
in 0.1 steps) RECORD > Player Set
0237 |00~ 03 Send/read Rise Time setting 0258 |00~ 03 Send/read the Skip Time setting
(00=2ms, 01=4ms, (00=3sec, 01=5sec,
02=6ms, 03=8ms) 02=10sec, 03=30sec)
0238 |00/01 Send/read Paddle Polarity setting SCAN > SCAN SET
(00=Normal, 01=Reverse) 0259 |00/01 Send/read the SCAN Speed setting
0239 |00~ 02 Send/read Key Type setting (00=Slow, 01=Fast)
(00=Straight, 01=Bug, 02=Paddle) 0260 |00/01 Send/read the SCAN Resume setting
0240 |00~ 02 Send/read MIC Up/Down Keyer setting (00=0OFF, 01=0ON)
(00=0FF, 01=ON (UP/DOWN), 0261 |00~ 10 Send/read the Pause Timer setting
02=ON (A/B)) (00=2sec ~ 09=20sec in 2 seconds,
DECODE > RTTY DECODE SET 10=HOLD)
0241 |00 ~03 Send/read the FFT Scope Averaging 0262 |00 ~ 06 Send/read the Resume Timer setting
setting (00=0sec ~ 05=5sec, 06=HOLD)
(00=0OFF, 01=2, 02=3, 03=4) 0263 |00~ 04 Send/read the Temporary Skip
0242 |Seep. 21. Send/read the FFT Scope Timer setting
Waveform Color setting (00=5min, 01=10min, 02=15min,
0243 |00/01 Send/read the Decode USOS setting 03=While Scanning,
(00=OFF 01=ON) 04=While Powered ON)
0244 |00/01 Send/read the Decode New Line 0264 |00/01 Send/read the MAIN DIAL Operation
Code setting (SCAN) setting
(00=OFF, 01=0N) (00=0OFF, 01=Up/Down)
0245 |00/01 Send/read the TX USOS setting GPS
(00=0OFF, 01=0ON) 0265 |00/01 GPS Set >
0246 |See p. 21. Send/read the Font Color (Receive) Send/read the Position Input setting
setting (00=Internal GPS, 01=Manual)
0247 [Seep.21. |Send/read the Font Color (Transmit) 0266 | 00/01 GPS Set > GPS Option >
setting Send/read the SBAS setting
DECODE > RTTY DECODE LOG 25 Too1 g)g;OSF':' O;ZC;N(; .
> >
0248 |00/01 Send/read the Decode Log setting © ption .
00=OFF. 01=ON Send/read the GLONASS setting
(00=0OFF, 01=0ON) (00=OFF, 01=0N)
0249 |00/01 Log Set > -
Send/read the File Type setting 0268 100/01 GPS Set > GPS Opt!on ” )
Send/read the Satellite Information
(00=Text, 01=HTML) 0 .
ut setting
0250 |00/01 Log Set > (00=GPS/QZSS/GLONASS,
Send/read the Time Stamp setting 01=GPS Only)
(00=0FF, 01=ON) 0269 |Seep.21. |GPS Set>
0251 {00/01 Log Set> _ . Send/read the Manual Position setting
Sggffead lthg 1T_”86Tf;tamp (Time) setting 0270 |00~ 02 Send/read the GPS TX Mode setting
(00=Local, 01=UTC) (00=OFF, 01=D-PRS, 02=NMEA)
0252 |00/01 Log Set >
Send/read the Time Stamp CRSEACRONM Mol DERS
(Frequency) setting 0271 |Seep. 19. Send/read the Unproto Address setting
(00=0OFF, 01=0N) (Up to 56 characters)
RECORD > Recorder Set 0272 |00~ 03 Send/read the TX Format setting
0253 |00/01 Sendiread the TX REC Audio setting (00=Position, 01=Object,
. - 02=Item, 03=Weather)
(00=Direct, 01= Monitor) EEEp——— EE—— E——
0254 [00/01 Send/read the RX REC Condition - ode > D-PRS > TX Format > Position
setting 0273 |00~ 03 Send/read the Symbol setting
(00=Always, 01=Squelch Auto) (8g=s°-;v 8;10-‘21'
0255 |00/01 Sendiread the File Split setting =No.3, 03=No.4)
(00=OFF, 01=ON) 0274 |See pp. 19 |Send/read the Symbol No.1 setting
and 21. (2 characters)
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Cmd. | Sub cmd. | Data | Description Cmd. | Sub cmd. Data | Description
1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Position 1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Object
0275 |Seepp. 19 |[Send/read the Symbol No.2 setting 299 |00~09 Send/read the Power setting
and 21. (2 characters) (00=0W, 01=1W, 02=4W, 03=9W,
0276 |[See pp.19 |Send/read the Symbol No.3 setting 04=16W, 05=25W, 06=36W,
and 21. (2 characters) 07=49W, 08=64W, 09=81W)
0277 |Seepp.19 |Send/read the Symbol No.4 setting 300 |00 ~09 Send/read the Height setting
and 21. (2 characters) (82=Zg1 08;6318 02;&2:19,503=24m,
- =49m, 05=98m, 06=195m,
0278 100~ 42 (S()%rldfriae_adot:f(_SoS)ID sefting 07=390m, 08=780m, 09=1561m)
02= -1 ~ 16= -15, 301 |00~ 09 Send/read the Gain setting
17=-A~ 42=-2) (00=0dB ~ 09=9dB)
0279 |00 ~03 Send/read the Comment setting 302 100 ~08 Send/feaﬁﬂ the Dir;activity settiong
(00=No.1, 01=No.2, 02=No.3, 03=No.4) (8(;:?3(22;:1;:51 ’;‘05580202902255;8\/\/
0280 |See p. 19. Send/read the Comment No.1 setting 06;270°W ’07=?315°NV,V OE_3=360°N5
(Upto 43 characters) 303 |00 ~42 Send/read t‘h SSID tt':
0281 |Seep. 19. Send/read the Comment No.2 setting (O%nz _r_e? 015(_ 0) setting
(Up to 43 characters) 02= -1 ~ 16= -15.
0282 |Seep. 19. Send/read the Comment No.3 setting 17=-A~42=-2)
(Up to 43 characters) 304 (00/01 Send/read the Time Stamp setting
0283 |Seep. 19. Send/read the Comment No.4 setting (00=DHM, 01=HMS)
(Up to 43 characters) GPS > GPS TX Mode > D-PRS > TX Format > ltem
0284 |00 ~ 02 Send/read the Time Stamp setting .
(00=OFF, 01=DHM, 02=HMS) 305 |[Seep.19. ?ngérga:h;ﬁzizzz)Name setting
0285 100/01 S()%’ld(’)rFelde‘:‘fg,'\}““de setting 306 |00/01 Sendlread the Data Type setting
(00=OFF, 01=ON) . . (00=Live ltem, 01=Killed Item)
0286 |00 ~ 02 Sen_d/read thf Data Extension setting 307 |See pp. 19 Send/read the Symbol setting
(00=OFF, 01=Course/Speed, and 21 (2 characters)
02=Power/Height/Gain/Directivity) 208 s '19 Send/read the G ¢ sett
0287 |00~ 09 Sendiread the Power setting eep. 19 (L'f" torig Ch:rac(t’;‘s")‘e" setting
(00=0W, 01=1W, 02=4W, 03=9W, P — -
04=16W, 05=25W, 06=36W, 309 See p. 21. Send/read the Position setting
07=49W, 08=64W, 09=81W) 310 (00 ~02 Send/read the Data Extension setting
0288 |00 ~ 09 Send/read the Height setting (00=OFF, 01=Course/Speed,
(00=3m, 01=6m, 02=12m, 03=24m, 02=Power/Height/Gain/Directivity)
04=49m, 05=98m, 06=195m, 311 000 ~ 360 Send/read the Course setting
07=390m, 08=780m, 09=1561m) (000 ~ 360=0° ~ 360°)
0289 |00~ 09 Send/read the Gain setting 312 (0000 ~ 1850 |Send/read the Speed setting
(00=0dB ~ 09=9dB) (0000=0km/h ~ 1850=1850km/h)
0290 |00~ 08 Send/read the Directivity setting 313 |(00~09 Send/read the Power setting
(00=0Omni, 01=45°NE, 02=90°E, (00=0W, 01=1W, 02=4W, 03=9W,
03=135°SE, 04=180°S, 05=225°SW, 04=16W, 05=25W, 06=36W,
06=270°W, 07=315°NW, 08=360°N) 07=49W, 08=64W, 09=81W)
GPS > GPS TX Mode > D-PRS > TX Format > Object 314 |00~ 09 Send/read the Height setting
0291 |See p. 19. Send/read the Object Name setting (00=3m, 01=6m, 02=12m, 03=24m,
(Up to 9 characters) 8‘;:;231 08;9?;10 06;;9?;;1
0292 |00/01 Sendiread the Data Type setting =390m, 08=780m, 09=1561m)
(00=Live Object, 01=Kill Object) 315 100 ~09 %%“dé;‘{;d tg: (932; setting
0293 |Seepp.19 |[Send/read the Symbol setting (00= — ) — -
and 21. (2 characters) 316 |00~ 08 (SO%ndéreaq t(i)11e ng'\(lﬁéwgyzsegt(t);né!
: =Omni, 01= ,02= ,
0294 |[Seep. 19. Stjancti/rigd :]he C(t)mment setting 03=135°SE, 04=180°S, 05=225°SW,
n F— (s pd‘/’ d° har"": ers) 06=270°W, 07=315°NW, 08=360°N)
eep.21.  |Send/read the Position setting 317 |00~ 42 Send/read the SSID setting
0296 |00~ 02 Send/read the Data Extension setting (00=- - -, 01=(- 0),
(00=0OFF, 01=Course/Speed, 02= -1~ 16=-15,
02=Power/Height/Gain/Directivity) 17=-A~42=-7)
0297 |000 ~ 360 Send/read the Course setting GPS > GPS TX Mode > D-PRS > TX Format > Weather
(000=0° ~ 360=360°) :
318 |[Seepp.19 |Send/read the Symbol setting
0298 |0000 ~ 1850 |[Send/read the Speed setting and 21. (2 characters)
(0000=0km/h ~ 1850=1850km/h)
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Cmd.| Sub cmd. | Data | Description Cmd. | Sub cmd. Data Description
1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Weather 1A* |05 |NB
319 |00 ~42 Send/read the SSID setting 0337 |00~09 Send/read the NB DEPTH setting
(00=- - -, 01=(- 0), (00=1 ~ 09=10)
02=-1~16=-15, 0338 |0000 ~ 0255 |Send/read the NB WIDTH setting
17=-A~42=-7) (0000=1 ~ 0255=100)
320 (Seep.19. Send/read the Comment setting VOX
(Up to 43 characters) 0339 |00~ 20 Send/read the VOX DELAY setting
321 |00 ~02 Send/read the Time Stamp setting (00=0.0s ~ 20=2.0s in 0.1s steps)
(00=OFF, 01=DHM, 02=HMS) 0340 |00~ 03 Send/read the VOICE DELAY setting
GPS > GPS TX Mode > NMEA (00=OFF, 01=SHORT,
0322*600/01 GPS Sentence > 02=MID, 03=LONG)
Send/read the RMC setting TX PWR LIMIT
- (00=OFF, 01=ON) 0341 |00/01 Sendiread the TX PWR LIMIT
0323 00/01 GPS Sentence > (144M) function setting
Send/read the GGA setting (00=OFF, 01=0ON)
- (00=OFF, 01=ON) 0342 |0000 ~ 0255 |Send/read the TX PWR LIMIT
0324*6(00/01 GPS Sentence > (144M) setting
Send/read the GLL setting (0000=0 ~ 0255=100)
(00=OFF, 01=ON) 0343 |00/01 Send/read the TX PWR LIMIT
0325”6 00/01 GPS Sentence > (430M) function setting
Send/read the GSA setting (00=OFF, 01=0N)
(00=OFF, 01=ON) 0344 |0000 ~ 0255 |Sendiread the TX PWR LIMIT
0326"6 00/01 GPS Sentence > (430M) Setting
Send/read the VTG setting (0000=0 ~ 0255=100)
(00=OFF, 01=ON) 0345 |00/01 Send/read the TX PWR LIMIT
0327*6|00/01 GPS Sentence > (1200M) function setting
Send/read the GSV setting (OOZOFF, 01 :ON)
(00=OFF, 01=ON) 0346 |0000 ~ 0255 |Send/read the TX PWR LIMIT
0328 |Seep. 19. Send/read the GPS Message setting (1200M) setting
(Up to 20 characters) (0000=0 ~ 0255=100)
GPS > GPS Alarm 0347 |00/01 Send/read the TX PWR LIMIT
0329 |See p. 21. Send/read the Alarm Area (Group) (2400M) function setting
setting (00=OFF, 01=ON)
0330 |00~ 02 Send/read the Alarm Area (RX/ 0348 |0000 ~ 0255 |Send/read the TX PWR LIMIT
Memory) setting (2400M) setting
(00=Limited, 01=Extended, (0000=0 ~ 0255=100)
02=Both) 0349 |00/01 Send/read the TX PWR LIMIT
GPS (5600M) function setting
0331 |00~ 06 Send/read the GPS Auto TX setting (00=0OFF, 01=0N)
(00=OFF, 01=30sec, 02=1min, 0350 |0000 ~ 0255 |Send/read the TX PWR LIMIT
03=3min, 04=5min, 05=10min, (5600M) setting
06=30min) (0000=0 ~ 0255=100)
DTMF > DTMF SET 0351 |00/01 Send/read the TX PWR LIMIT (10G)
0332 |00~ 03 Send/read the DTMF Speed setting function setting
(00=100ms, 01=200ms, (00=0FF, 01=0N)
02=300ms, 03=500ms) 0352 |0000 ~ 0255 |Send/read the TX PWR LIMIT (10G)
VIDEO > VIDEO SET Sgét(i)%g 0~ 02552100
0333 [0000 ~ 0255 |Send/read the AV-IN Video Input (0000= =100)
Level setting cb
(0000=0% ~ 0255=100%) 0353 |00/01 Send/read the Call Sign Display/
0334 {0000 ~ 0255 |Send/read the AV-OUT Video Output Name Display setting
Level setting (00=Call Sign Display,
(0000=0% ~ 0255=100%) 01=Name Display)
0335 |00~ 02 Send/read the View Mode setting GPS Position
=Normal, =rull, =Zo0om ~ end/read the Compass Direction
(00=Normal, 01=Full, 02=Zoom) 0354 |00~ 02 Send/read the Compass Directi
NB setting
0336 |0000 ~ 0255 |Sendiread the NB LEVEL setting (8222533:”3 l)Jp’ 01=North Up.
(0000=0% ~ 0255=100%) P




REMOTE CONTROL

Remote control (CI-V) information

<© Command table

Cmd. | Sub cmd. Data Description Cmd.| Sub cmd. Data Description
1A* |06 See p. 23. Send/read the DATA mode setting 20 03 [00* 00/01 Send/read the Auto DV RX
07 00/01 Send/read the NTP server access GPS/D-PRS data output
(00=Terminate, 01=Initiate) (00=0FF, 01=0N)
08*1 00 ~ 02 Read NTP server access result 0100 |[See p. 25. Output DV RX GPS/D-PRS Position
(00=Accessing, or have not for transceive
accessed after Power ON, 0101 |See p. 25. Output DV RX D-PRS Object status
01=Succeeded, 02=Failed) for transceive
09*! 00/01 Read the OVF indicator status 0102 |See p. 26. Output DV RX D-PRS Item status
(00=0OFF, 01=0ON) for transceive
0A 00 ~ 02 Send/read the Share Pictures 0103 |See p. 26. Output DV RX D-PRS Weather
function status status for transceive
(00=OFF, 01=ON, 02=ON (Repeat)) 0200 |See p. 25.  |Read Auto DV RX GPS/D-PRS
® While transmitting the picture Position status
using the DV Fast Data function, 0201*'|See p. 25.  |Read Auto DV RX D-PRS Object
sends ON even if the status is set tat
to OFF. 1 stalus
1B* |00 See p. 23. Send/read the Repeater tone frequency 0202""| See p. 26. SRtZ?:SAUtO DV RXD-PRS ltem
01 See p. 23. Send/read the TSQL tone frequency 0203*| See p. 26. Read Auto DV RX D-PRS Weather
02 See p. 23. Send/read the DTCS code and polarity status
07 See p. 23. Send/read the CSQL code (DV mode) 04 |00* 00/01 Send/read Auto DV RX GPS/D-PRS
1C |00* 00/01 Send/read the transceiver’s status message output
(00=RX, 01=TX) (00=0FF, 01=0ON)
02* 00/01 Send/read the Transmit frequency 01 See p. 26. Output DV RX D-PRS message for
monitor (XFC) transceive
(00=0OFF, 01=ON) 02*" [See p. 26. Read Auto DV RX D-PRS message
03* See p. 16. Read the transmit frequency status
1E |00* Read number of available TX 21* |00 See p. 27. Send/read the RIT frequency
frequency band 01 00/01 Send/read the RIT setting
01+ See p. 16. Read TX band edge frequencies (00=0OFF, 01=0ON)
02*1 Read number of user-set TX 02 00/01 Send/read the ATX setting
frequency band (00=0OFF, 01=0ON)
03* See p. 16. Send/read the user-set TX band 22 00 See p. 27. Set the DV TX data (Up to 30 byte)
edge frequencies 01 [00* |00/01 Set the Auto DV RX data output
1F* |00 See p. 23. SET > My Station > (00=0FF, 01=0ON)
Send/read the My Call Sign setting 01 See p. 27. Set the DV RX data for transceive
01 Seep.23. |CS> _ 02* 00/01 SET > DV/DD Set >
Send/read the UR, R1, R2 setting Send/read the DV Data TX setting
02 See p. 23. SET > My Station > (00=PTT, 01=Auto)
Send/read the TX Message setting 03* 00/01 SET > DV/DD Set > DV Fast Data >
20 00 |00* 00/01*7 Send/read the Auto DV RX Call Send/read the Fast Data setting
signs output (00=OFF, 01=0ON)
(00=OFF, 01=ON) 04* 00/01 SET > DV/DD Set > DV Fast Data >
01 See p. 24. Output DV RX Call signs for Send/read the GPS Data Speed setting
transceive (00=Slow, 01=Fast)
02*'  |See p. 24. Read Auto DV RX Call signs 05* 00~10 SET > DV/DD Set > DV Fast Data >
01 [00* |00/01%7 Send/read the Auto DV RX message Send/read the TX Delay (PTT) setting
(00=0OFF, 01=1sec ~ 10=10sec)
output
(00=OFF, 01=0ON) 23 00*! See p. 27. Read the position status
01 See p. 24. Output DV RX message for 01* 00/01 GPS > GPS Set >
transceive Send/read the Position Input setting
02*! |See p. 24. Read Auto DV RX message (00=Internal GPS, 01=Manual)
02 |00* |00/01* Send/read the Auto DV RX status 02 Seep.21.  |GPS>GPS Set >
output Send/read the Manual Position setting
(00=OFF, 01=0ON) 24 00 (00* 00/01 Send/read TX output power setting
01 See p. 24. Output DV RX status for transceive (00=0OFF, 01=ON)
02*' |See p. 24. Read Auto DV RX status 01 00/01 Set the TX output power for transceive
(00=0FF, 01=0ON)
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REMOTE CONTROL

Remote control (CI-V) information

<© Command table

Cmd.

Sub cmd.

Data

Description

Cmd. [ Sub cmd. Data Description

25*

See p. 27.

Send/read the selected or
unselected VFO frequency

26*

See p. 27.

Send/read the selected or unselected
VFO'’s operating mode and filter

27*

00

See p. 28.

Read the Scope waveform data
(Only when “Scope ON/OFF status”
(Command: 27 10) and “Scope
wave data output” (Command: 27
11) are set to “ON,” outputs the
waveform data to the controller.)

00/01

Send/read the Scope ON/OFF status
(00=0OFF, 01=0ON)

00/01

Send/read the Scope wave data
output
(00=0OFF, 01=0ON)

00

Send/read the Main or Sub scope
setting
(00=Main (fixed))

00

Send/read the Single/Dual scope
setting
(00=Single (fixed))

0000 ~ 0003

Send/read the Scope Center mode,
Fixed mode, SCROLL-C mode, or
SCROLL-F mode setting
(0000=CENTER mode,

0001=FIX mode,
0002=SCROLL-C mode,
0003=SCROLL-F mode)

See p. 28.

Send/read the Span setting in the
Center mode or SCROLL-C mode
Scope

0001 ~ 0004

SCOPE > SCOPE SET >
Send/read the Scope Edge Number
setting in the Fixed mode or
SCROLL-F mode

(0001=Fixed Edges No.1,
0002=Fixed Edges No.2,
0003=Fixed Edges No.3,
0004=Fixed Edges No.4)

0000/
0001

Send/read the Scope Hold function
ON/OFF status
(0000=0OFF, 0001=0ON)

See p. 28.

Send/read the Scope Reference
level setting

0000 ~ 0002

Send/read the Sweep speed setting
(0000=FAST, 0001=MID, 0002=SLOW)

00/01

SCOPE > SCOPE SET >
Send/read the Scope during Tx
(CENTER TYPE) setting
(00=0OFF, 01=0ON)

00 ~ 02

SCOPE > SCOPE SET >

Send/read the CENTER Type
Display setting

(00=Filter Center,

01=Carrier Point Center,

02=Carrier Point Center (Abs. Freq.))

0000/
0001

Send/read the Scope VBW setting
(0000=NAR, 0001=WIDE)

See p. 29.

Send/read the Scope Fixed Edge
frequencies

15

27* |20 00/01 SCOPE > SCOPE SET >
Send/read Marker Position (FIX
Type/SCROLL Type) setting

(00=Filter Center, 01=Carrier Point)

Transmit the Voice TX Memory
(00=Stop, 01=T1 ~ 08=T8)

28 |00 00 ~ 08

*(Asterisk) Send/read data

*1 Read only data

*2 Send only data

*3 In the CW mode, if the [PTT] or an external TX switch is ON, or the
Break-in function is ON, a message will be transmitted as CW code
when you send it from your PC.

*4 Sending the power ON command (18 01) turns ON the transceiver
when the transceiver is OFF (Standby/Shutdown).

*5 To insert a counter, first clear the other channel’s counter.

*6 Set at least 1 GPS sentence to ON.
Up to 4 GPS sentences can be set to ON at the same time.

*7 Qutput setting is automatically set to OFF after turning OFF the
transceiver.

*8 |In the 10 GHz band, the drain voltage can be read only while
transmitting, because the power amplifier control method is different
from other bands.



REMOTE CONTROL

Remote control (CI-V) information

<& Command formats

» Operating frequency + Band edge frequency settings
Command: 00, 03, 05, 1C 03 Command: 02, 1E 01, 1E 03

© @ 6 ® 6 ® O 6® O O b @

©
®
®
1®
@
®

DX [xix [ xox [ xox [ xix[orx ] o xixpixxixxix[xix|xix]2p[x:x[xix|xix[xix|xix]
1 !
= o
To] L f? LLIP o 22PN
(o)} 9 L (o] I » l
o o @ 1 2o % 5 N_Cgv‘_ = mm,ovcl’o)“‘_c’),\@o-,c;’zc;’,c»(\'_é
8 o 1] o 1] o 1 ~ > o . "103110101‘_..810’2 OOI‘_-.
? ! ' © 5 °© T o o ¥ & 7 Y o1 o8P 00l X o1 o299 JocE
2 o S &5 & F & o 22 F S sosEoEbusg & co g8 5us D
5 =2 5 2 8 235 @5 2 % 3 E DE5802029 5 D08 o802y
T 2 T N N © T T T N 2 D20 yPNNTOT § T2 P NTTOI
S N T N T N N T NONTxTIHPNS § NONTxITI RN
E N E I x E = £ =T = 0 O %INIoo-“EIIo S INIOO¥§IIO
s T ¥X88 532 =038385o T ofiSSeeZ?8 g oT¥8800208
. L High

® When the 5600 MHz or lower band is selected, the ower edge igher edge

number of digits is 10 (D ~ ®). * When obtaining the edge number (by command “02”), the
When the 10 GHz band is selected, the number of digits edge number (D) is not returned.

is 12 (D ~ ®) from 100 GHz to 1 Hz. ® When the 10 GHz band is selected, the each Edge
frequency is 12 digits (6 bytes) from 100 GHz to 1 Hz.
+ Operating mode ©® @066 60 ® @ OO @ 6 @

Command: 01, 04, 06 XXX pixpixxixoix]2 Dl xixxix[xix[o X

= Y T TT TT
XX | x ! x L °
(X x[x %] I 8 |
t ) n @ X o 0@ X
: : i 50le?1290d S 201621270 S
(DOperating mode (2Filter setting Ut co .%o U St co .
L ’?’o?ooéguuo ] '?‘o?ooégupo
00:LSB 07:CW-R 01:FIL1 8 CoC0LoEEs 295 Co0EoE 5295
E 52 50020220 N 5 OEDEO2029y o
01:USB 08:RTTY-R 02:FIL2 2 OO WY NNTOOIING D2B PN NTOI I N
o BNNISTIIE=05 5§ §FUNT2ISITI=03
02:AM 17:DV 03:FIL3 g oL¥880020880 § oL¥882229880
03:CW 22 :DD* —
04-RTTY 23 ATV* Lower edge Higher edge
05:FM — —

* The operating mode can be set when the 1200 MHz or
higher band is selected.
@ Filter setting, (@) can be skipped with command 01. In
that case, “FIL1” is selected with command 01.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Duplex Offset frequency setting
Command: 0C, 0D

1

®

1

1 kHz digit: 0 ~9 ——>{ X
100 Hz digit: 0 ~9—> X

100 kHz digit: 0 ~9—> X

10 kHz digit: 0 ~9—> X
10 MHz digit: 0 ~9——>| X

1 MHz digit: 0 ~9 ——>| X

® The 10 MHz digit can be set when the 1200 MHz or
higher band is selected.

+ Codes for CW message contents
Command: 17 (Up to 30 characters)
To send CW messages, use the following character

codes.

Character | ASCIl code | Character | ASCIl code
0~9 30~39 27
A~Z 41 ~ 5A ( 28
a~z 61 ~7A ) 29

/ 2F = 3D

? 3F + 2B
2E ? 22

- 2D @ 40

, 2C Space 20
3A

® “FF” stops sending CW messages.
® “M is used to transmit a string of characters with no
inter-character space.

17



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* Memory content
Command: 1A 00

OO\ 3,606  —O0~0— @ @ ® ® — ©®~0@ —— O~ —/ — @~ —

XXX XXX x| o: x[Xix]---o |><§><|><i><|><§><|><i><|><§><|><§O|><§><|><§><|><§><><i><|><i><|><i><|><§><|><§><|><§><|j

® BB~ O~® ——D-B -9 98—
DX PEXPXEXPXEXXEX - XXX XXX XXX [ XX
®, @: Memory group number @5: Digital squelch setting
0000 ~ 0099: Memory channel group ®
0100: Call channel group
3, @: Memory channel numbers T Y ried

* When Memory channel group is selected, 0=Digital squelch function OFF
0000 ~ 0099: 00 ~ 99 1=Digital call sign squelch function ON (DSQL)

* When Call channel group is selected, 2=Digital code squelch function ON (CSQL)
0000, 0001: 144 C1, C2 (©~08: Repeater tone frequency setting
0002, 0003: 430 C1, C2 19~Q): Repeater tone frequency setting
0004, 0005: 1200 C1, C2 ® See “Repeater tone/tone squelch frequency setting.”
0006, 0007: 2400 C1, C2 (p. 23)

0008, 0009: 5600 C1, C2 .
0010, 0011: 10G C1, C2 @~@: DTCS code setting

® See “DTCS code and polarity setting.” (p. 23)

@): DV Digital code squelch setting
® See “DV Digital code squelch setting.” (p. 23)

(®: Split and Select memory setting
®

1= %1 29~@: Duplex offset frequency setting
L 2= %2 ® See “Duplex Offset frequency setting.” (p. 17)
Fixed = @9~G9: UR (Destination) call sign setting
* Set 0 for Call channel. (8 characters, fixed)
@D~@: R1 (Access repeater) call sign setting
(©)~(9: Operating frequency setting (8 characters, fixed.)
® See “Operating frequency.” (p. 16) @5~62: R2 (Gateway/Link repeater) call sign setting
(@, @: Operating mode setting (8 characters, fixed)
® See “Operating mode.” (p. 16) ® See “DV TX call signs setting.” (p. 23)
@: Data mode setting 63~6: Memory name setting (16 characters, fixed)
1 byte data (XX) ® See “Codes for character entries.” (p. 19)
8(1) BZ:Z :ggg 82': To clear the memory channel contents on 1A 00:
_ (M, @: Memory channel group (0000~0099)
(@: Duplex and Tone settings You cannot specify group “0100” (Call channel
group)
[0=OFF % @: Mg@mory channel (0000~0099)
' 1=TONE . “FF,” ® ~ : None
- 2=TSQL
0=Duplex OFF 3=DTCS
1=Duplex- 4=DTCS(T)
2=Duplex+ 5=TONE(T)/DTCS(R)
3=RPS 6=DTCS(T)/TSQL(R)
| 7=TONE(T)/TSQL(R)

® RPS can be set when DD mode is selected, and Duplex
(+, -) can be set when other than DD mode is selected.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Codes for character entries » Band stacking register
Command: 1A 00, Command: 1A 01
1A 05 0179, 0271, 0291, 0293, 0294,
0305, 0308, 0320, 0328 @ @
1A 05 0274 ~ 1A 05 0277, [ x i x [ x x|

1A 05 0280 ~ 1A 05 0283
NOTE: When sending the contents, the codes, such
- Character codes— Letters and Numbers as operating frequency and operating mode*, should
Character | ASCll code | Character | ASCIl code be added after the frequency band code and the
register code, as shown below.

A~z 4~ 5A a~z o1~7A * See ® ~ 62 on “Memory content.” (p. 18)
0~9 30 ~ 39
- Character codes— Symbols @: Frequency band codes

Character | ASCll code | Character | ASCII code Code | Freq.band | Frequency range (unit: MHz)
| 21 # 23 01 144 144.000000 ~  148.000000
$ 24 % 25 02 430 430.000000 ~ 450.000000
& 26 \ 5C 03 1200 1240.000000 ~ 1300.000000
2 3F ” 22 04 2400 2300.000000 ~ 2450.000000
, 27 . 60 05 5600 5650.000000 ~ 5925.000000
A 5E + 2B 06 10G 10000.000000 ~ 10500.000000
- 2D * 2A
/ oF , 2F 2: Register codes
, 2C : 3A Code | Registered number
; 3B = 3D 01 |1 (Display on left side)
< 3C > 3E 02 |2 (Display in center)
( 28 ) 29 03 |3 (Display on Right side)
[ 5B ] 5D
{ 7B } 7D To read the contents, the register code should be
| 7C 5F added after the frequency band code, as shown
- - below.

7E 40 . . .
e Example: When reading the frequency displayed in
the center of the display in the UHF band,
Cmd. | Sub cmd. Set item/selectable characters use code “0202.”
1A 00 Memory name
All characters are usable.
05 |0179 |NTP Server Address
A~Z a~z0~9,.,-
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ Keyer memory character entries
Command: 1A 02

+ AGC time constant settings
Command: 1A 04

- Character codes Data AGC time constant (sec.)
e SSB/CW/RTTY AM
Character | ASCII code Description 00 OFF OFF
0~9 30 ~39 Numbers 01 01 03
A~Z 41 ~5A Letters 02 0.2 05
Spfce 22 W;rdr:sjce 03 0.3 0.8
? 3F Szmbol o 05 12
05 0.8 1.6
’ 2C Symbol 06 12 2.0
: 2E Symbol 07 16 25
2 ° Example: toSZZ::joL_T 08 20 30
§ 5E P enter "425’4 09 2.5 4.0
. oA Inserts the contest number 10 3.0 5.0
(can be used for 1 channel only) 11 4.0 6.0
12 5.0 7.0
® Information 13 6.0 8.0

* “FA” (NG) is returned if you insert the content number in
more than 1 channel.

» Spaces after the end of the sentence are not necessary.

» To clear the Keyer memory contents, send one or more
spaces.

* Keyer memory content
Command: 1A 02

@ ~ @: Text data

* RX HPF/LPF setting for each operating mode
Command: 1A 05 0001, 0004, 0007, 0010, 0015, 0016

HPF (Lower edge) J L LPF(Upper edge)

00=Through 05 ~ 24=500~2400 Hz
01 ~20=100 ~ 2000 Hz 25=Through

® The value of the HPF should be smaller than the LPF.

+ SSB/SSB-DATA transmission passband width
settings
Command: 1A 05 0019 ~ 0022

Lower edge Higher edge

(D: Channel data 0=100 Hz 0=2500 Hz
01=M1 05=M5 b Lower edge 1=200Hz  1=2700 Hz
02=M2  06=MS Higher edge 3- 500 s 3- 2900 Hz
03=M3 07=M7
04=M4~ 08=M8 - Split offset frequency setting

Command: 1A 05 0047
* IF filter width settings @ @ ©) @
Command: 1A 03 [x "o x i x]o i x[x i x|
Mode Data Steps T T T T T
SSB/CW/RTTY| 0~9 |50~ 500Hz (50 Hz) o [ ? olv I ®  Direction:
SSB/CW 10 ~40 |600 Hz ~ 3.6 kHz (100 Hz) L e 2 o 2 & 00=+ direction
RTTY 10 ~ 31 |600 Hz ~ 2.7 kHz (100 Hz) g E’ 2 éa 2 g 01=-direction
AM 0~49 |200 Hz ~ 10.0 kHz (200 Hz) N T N R E
T ggg 2 2gfs
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ UTC Offset setting * Manually entered position data
Command: 1A 05 0181 Command: 1A 05 0269, 0295, 0309,
X x| x i x| x x| 2302
) I fd OO —O~ Oy — @~ B
Offset time Shift direction XX e [XEX]XEX] oo [XEX]XEX] e [XEX
0000 ~ 1400 00=+ (plus) T
01=- (minus) DO @66 OO O MmN ®H O

Dexxix|xix|x:0] o xo:x|x:x|x:x[xix|x:0[0ix[xix|xix|xix|0iX]

» Color settings A
Command: 1A 050191, 0192, 0193, 0224, I I
0226, 0242, 0246, 0247 3 El
= o,
@® @ ® @ ® ® o | 2]« 2| | 5+
> o m,é Tl 1o mzé B ! o
o ix][xix]oix]xix]oix|x x| LTL9822 | |2194740%622 ] [E224To
: : : : : : O o uEeD S |£E o oo ED S S te
\ /\ /\ / 5efuo8o | | b |2525u080 | | $°25:22%
R (Red) G (Green) B (Blue) Soo2essl 13185998831 128 5%
0000 ~ 0255 0000 ~ 0255 0000 ~ 0255 8oL ZEEg oo 8522 EEYSE s ST
OPEEEEg XXEXOODEEEEg X X8 B EX]
SCeE588558582°2555855588882552T
+ Bandscope edge frequency settings Latitude Lonaitude Altitude

Command: 1A 05 0199 ~ 1A 05 0222 @ ~ ®: Latitude (dd°mm.mmm format)

® ~ (): Longitude (ddd°mm.mmm format)

© ® ®© ® © ©® © ® @2 ~ (: Altitude (0.1 meter steps)

|X§0|X§X|X§X|X§X|0§X|X§0|X§X|X§X|X§X|0§X| * When reading the contents with no altitude, sends @, @),
T T r T T I @, and @ as “FF.”
— o | 3 = o | 3 * When sending the contents with no altitude, set (2, @), (9,
g PO & 8 P o X and ® to “FF.”
gclvo,o?mw_,b‘_ £70%25 02050 .
mvolol\—ooo.ojvolol\—ooo.
6P N O NN_LSPNO O NNT .
NEIEENN§5£NEIEENN§5E * D-PRS Symbol setting
Lo SIFZo0Llz2Es5235220 Command: 1A 05 0274 ~ 1A 05 0277,
ZegegZlogeigegesleee 1A 05 0293, 0307, 0318
[ I | ’ ’
Lower edge Higher edge

[ x  x [ x x|

) )
First digit Second digit
*/\,0t0 9, Ato Z can be used for the first digit
character.

« See “Codes for character entries” for the second
digit character. (p. 19)

» Alarm area (Group) setting
Command: 1A 05 0329

® @ ®

[ x x| xix[x:o|

IR

()]

o) @

T o 1 & ©°

o t o 5

] o = k=) =

5 & © B °
° = ? c £ B
s 2 £ € E 3
o & = o & £
-~ ~ O o o o
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ [VOX/BK-IN] setting * Remote MIC Key setting
Command: 1A 05 0075 Command: 1A 05 0077 ~ 0080
Data Function Data Function
00 TRANSMIT 00 No function
01 VOX/BK-IN 01 UP
02 P.AMP/ATT 02 DOWN
03 NOTCH 03 UP (VFO: kHz)
04 NB 04 DOWN (VFO: kHz)
05 NR 05 VOL UP
06 SPLIT 06 VOL DOWN
07 A/B 07 XFC
08 VFO/MEMO 08 CALL
09 CD 09 VFO/MEMO
10 PRESET 10 DR
11 Home CH 11 FROM/TO (DR)
12 Temporary Skip 12 Home CH
13 Voice/Keyer/RTTY Memory 1 13 BAND/GROUP UP
14 Voice/Keyer/RTTY Memory 2 14 BAND/GROUP DOWN
15 Voice/Keyer/RTTY Memory 3 15 SCAN
16 Voice/Keyer/RTTY Memory 4 16 Temporary Skip
17 SPEECH
18 MODE
- [AUTOTUNE/RX>CS/AFC] setting 19 |RF Power
Command: 1A 05 0076 20 Voice/Keyer/RTTY Memory 1
Data Function 21 Voice/Keyer/RTTY Memory 2
00 AUTOTUNE/RX>CS/AFC 22 Voice/Keyer/RTTY Memory 3
01 CD/RX>CS 23 Voice/Keyer/RTTY Memory 4
02 PRESET/RX>CS 24 TCALL”
03  |Home CH/RX>CS 25 |RX>CS
04 Temporary Skip/RX>CS 26 s
27 MPAD
28 SPLIT
29 A/B

* Only for European version.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ Data mode with filter width settings + DV MY call sign setting
Command: 1A 06 Command: 1F 00
Set your own call sign and note of up to 12 characters.
@ @ “ ’ H ”
. . See “Character’s code of the call sign.
r 3t O-O0——0-0
00=Data mode OFF*  01=FIL1 XX e XX XEX]XEX XX XEX]
01=Dat de ON 02=FIL2
atamode 03=FIL3 (M ~ ®: Your own call sign setting (8 characters)

N . (9 ~ : Note setting (4 characters)
When 00 is set, also set 00 to @.

* Repeater tone/tone squelch frequency settings

e DV TX call si ing (24 ch
Command: 1B 00, 1B 01 call signs setting (24 characters)

Command: 1F 01

Ok @ ©) (Sf_et dl_)lR “R1,” and “R2” call signs of 8 characters

T ; . 1Xeq).
0 0 X X X X

| | n | 3 | See “Character’s code of the call sign.”
BN
1 A » 1

5 5 S o i 9 (OO —0-O— —D-B—
= 2 5 £ I 5 [XX] oo X X[ XX oo XXX oo x|
2 2 s 2 5 = e S B '
3 3 T £ ~ T M ~ ®: UR (Destination) call sign setting
X < Q T -
i i =] =] - S (8 characters)

@ ~ (®: R1 (Access/Area repeater) call sign setting
(8 characters)
(D ~ @: R2 (Link/Gateway repeater) call sign setting

*Not necessary when setting a frequency.

* DTCS code and polarity setting (8 characters)
Command: 1B 02
Character’s code of the call sign
® @ ® g
| X X | 0 . x | X . X | Character | ASCII code
T 0~9 30~ 39
T ~ T A~Z 41 ~5A
t ~
~ o ) (Space) 20
o =) e
L2 3 % / 2F
g = & 3
s & & £
— Receive polarity: 0=Normal * DV TX message setting
1=Reverse Command: 1F 02

Transmit polarity: 0=Normal

Set the transmit message of up to 20 characters.
1=Reverse

See “Codes for character entries.” (p. 19)
“FF” stops sending or reading messages.
+ DV Digital code squelch setting
Command: 1B 07

x
e
X

First digit: 0 ~ 9 —>
Second digit: 0 ~ 9 —>
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* DV RX call sign data
Command: 20 0001, 0002

OO0 —@~0 -7 0O~8—©®~@
[xx[xix|x:x] - |X:X|X:X|X:X|X:X| o [xix] )
@~ @D ~
] - B - B
(D: Header flag data (First byte)
Data Description
bit7 | (O: Fixed) —
bité | (0: Fixed) —
bit5 | (O: Fixed) —
bit4 0/1 0=Voice, 1=Data
bit3 0/1 0=Direct, 1=Through repeater
bit2 0/1 0=No Break-in, 1=Break-in
bit1 0/1 0=Data, 1=Control
bit0 0/1 0=Normal, 1=EMR

(2: Header flag data (Second byte)

Data L
bit2 | bit1 | bit0 Description
1 1 1 | Repeater control
1 1 0 |Send auto acknowledge
1 0 1 | (Not used)
1 0 0 |[Request to re-transmit
0 1 1 | Send acknowledge
0 1 0 |Receive no reply
0 0 1 |Repeater disabled
0 0 0 |NULL

(3 ~ (0: Call sign of the caller station
(8 characters, fixed)

@) ~ (9: Note of the caller station
(4 characters, fixed)

@ ~ @: Call sign of the called station
(8 characters, fixed)

@ ~ (9: Call sign of the access/area repeater (R1)
(8 characters, fixed)

8D ~ @3: Call sign of the link/gateway repeater (R2)
(8 characters, fixed)

See “Codes for character entries.” (p. 19)

® FF: When no call sign is received since the transceiver

power was turned ON.
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* DV RX message
Command: 20 0101, 0102

O~ —D~B—— O~ @

DXX] o XXX e XXX XXX

@ ~ @: Message (20 characters)

@) ~ @: Call sign of the caller station (8 characters)

~ 32: Note of the caller station (4 characters)

See “Codes for character entries.” (p. 19)

® FF: When no call sign is received since the transceiver
power was turned ON.

Example: When a Gateway call is received

iy, JM1ZLK calllng from
Jp,;‘or ) RXRPT2 JP1YIU port A
/Uaoca//”’ 9 1
7t4 o
k’ ﬁ i
PT1 7D

X
INTERNE"

CALLED

YOU R STATION

CALLER:
CALLED:
RXRPT1:

Caller’s call sign

Called station call sign

Call sign of the repeater that was accessed

by the caller station

@ If it was a call through a gateway and the
internet, this item displays the gateway
call sign of the repeater you received the
call from.

RXRPT2: Call sign of the repeater you received the

call from

* DV RX Status setting
Command: 20 0201, 0202

Data Function Description
bit7 | 0 |(Fixed) —
While receiving a digital voice
. Receiving a signal, select “1.”
2is /1 voice call (Regardless of DSQL and
CSAQL setting)
bit5 | 0/1 L.a.st call When the last Sal,! was finished
finisher by you, select “1.
bita | 0/1 R_ecewmg a When the auc{‘lo }one can be
signal heard, select “1.
bit3 | 0/1 Receiving a While l;ec:alvmg a BK call,
BK call select “1.
. Receiving a While receiving a EMR call,
bit2 | 01 | EViR call select “1.”
Receiving a w .
bit1 | 0/1 |signal other \é\lll:i; D\S/elzgfnf,!vl are
than DV 9 '
bito | 0/1 Packet loss }‘NP!Ie displaying packet loss,
status 1” is returned.




REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* GPS/D-PRS data
Command: 20 03 0100, 0101, 0102, 0103,
0200, 0201, 0202, 0203

Data number and description

Data number Description
00 D-PRS — Position
01 D-PRS — Object
02 D-PRS — Item
03 D-PRS — Weather

Position
Command: 20 03 0100, 0200

_\
|X:X|X:X|X:X|X:X| _:'_'_'_"__|X:X|j

[olofxx] -

"'—\@

"""" [xxxix]xx]~

@@ @
Pxxix|xixx x|x:x]

: Call sign/SSID

(9 ASCII characters (A~2,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)

. Longitude (ddd’mm.mmm format)

. Altitude (0.1 meter steps)

Course (1 degree steps)

Speed (0.1 km/h steps)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

I-
2?

1§

8

1§

CICISISISICIE
l§ l§
PO 8®®

~ ®: See the table below.
Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)
0 0 3/10 0 Omni-direction
1 1 6/20 1 45° NE
2 4 12/40 2 90° E
3 9 24/80 3 135° SE
4 16 49/160 4 180° S
5 25 98/320 5 225° SW
6 36 195/640 6 270° W
7 49 390/1280 7 315° NW
8 64 780/2560 8 360° N
9 81 1561/5120 9 —

@ The item, that is not contained the received data, is filled
with “FF.”
® FF: No signal has been received since the power was
turned ON.
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Object
Command: 20 03 0101, 0201

0:1]xix]

"‘—\@

. Call sign/SSID

(9 ASCII characters (A~2,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)

. Longitude (ddd’mm.mmm format)

. Altitude (0.1 meter steps)

Course (1 degree steps)

Speed (0.1 km/h steps)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

l-
2?

1§

8

1§

CICISISISICIO
l§ l§
®O-8®®

~ @): See the table below.
Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)
0 0 3/10 0 Omni-direction
1 1 6/20 1 45° NE
2 4 12/40 2 90° E
3 9 24/80 3 135° SE
4 16 49/160 4 180° S
5 25 98/320 5 225° SW
6 36 195/640 6 270° W
7 49 390/1280 7 315° NW
8 64 780/2560 8 360° N
9 81 1561/5120 9 —
~G): Name
(9 ASCII characters (00h ~ EFh))
62: Type (1= Live, 0= Killed)

® The item, that is not contained the received data, is filled
with “FF.”
® FF: No signal has been received since the power was
turned ON.



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ GPS/D-PRS data (Continued)

Item
Command: 20 03 0102, 0202

[0:2]xix]

C/—.T..@—\@ @ ®
|xzx|xzx|xzx|xzx|xzx|j

. Call sign/SSID
(9 ASCII characters (A~2,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)
: Longitude (ddd°mm.mmm format)
: Altitude (0.1 meter steps)

Course (1 degree steps)

l-
2?

i

R
l
oo

~ @D: Speed (0.1 km/h steps)
~39: See the table below.
@2 Power | 3 Height Gain | 39 Directivity
Data (W) (mift) (dB) (deg)
0 0 3/10 0 Omni-direction
1 1 6/20 1 45° NE
2 4 12/40 2 90° E
3 9 24/80 3 135° SE
4 16 49/160 4 180° S
5 25 98/320 5 225° SW
6 36 195/640 6 270° W
7 49 390/1280 7 315° NW
8 64 780/2560 8 360° N
9 81 1561/5120 9 —
~ @: Name
(9 ASCII characters (00h ~ EFh))
@: Type (1= Live, 0= Killed)

® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.
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Weather
Command: 20 03 0103, 0203

[0:3]xix]

xix]

O ~@: Call sign/SSID

(9 ASCII characters (A~Z,0~9, /, -, space))

Symbol (2 ASCII characters (00h ~ EFh))

Latitude (dd°mm.mmm format)

Longitude (ddd°’mm.mmm format)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

Wind direction (1 degree steps)

Wind speed (0.1 m/s steps)

Gust speed (0.1 m/s steps)

: Temperature (0.1°C steps)
Temperature (0= + degree, 1= — degree)
Rainfall (0.1 mm steps)
Rainfall (24 hours) (0.1 mm steps)
Rainfall (Midnight) (0.1 mm steps)
Humidity (1% steps)

@: Barometric pressure (0.1 hPa steps)

I

SISICIE
l§ l§ @
PRS-

; -

PPPeRRE®E®
SISIEIS é@@@

® The item, that is not contained the received data, is filled
with “FF.”
® FF: No signal has been received since the power was
turned ON.

+ GPS/D-PRS message
Command: 20 0401, 0402

—® ~ @—,—@ ~ @—
xix| - - [xix|xix] - - - [xiX]
(Variable length)

@ ~ @: Call sign/SSID

(9 ASCII characters (A~2,0~9, /, -, space))
~ 62: Message

(Up to 43 ASCII characters (00h ~ EFh))
® FF: No signal has been received since the power was

turned ON.




REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* RIT frequency settings » Selected or unselected VFO frequency settings
Command: 21 00 Command: 25
[ x x| x i x| x i X [XIX]X XXX XX XEX] XX

T T T CL L I I

o o l 00=Selected VFO Operating frequency

é 017 CI> o 01=Unselected VFO See “Operating frequency.” (p. 16)

.. o .. N

T N T 00:+ (plus) ® When using the DR function, the transceiver returns

= - - e 01: — (minus) “FA” (NG) because these cannot be set to 01.

* When VFO Ais selected
« DV TX data 00=frequency of VFO A changes
Command: 22 00 01=frequency of VFO B changes
* When VFO B is selected
...................... O~ _
; 00=frequency of VFO B changes
KR o 01=frequency of VFO A changes
(Variable length) q y 9

(D ~ 39: TX data (Up to 30 Byte) + Selected or unselected VFO’s operating mode
@ “FA” to “FF” are entered after converted to “FF OA” to “FF and filter settings

OF” automatically. Up to 60 Byte data can be entered in Command: 26

this case.

Both data and filter settings can be skipped. In that
case, “DATA OFF” and the default filter setting of the

« DV RX data (transceive) operating mode is automatically selected.
Command: 22 0101 @Data mode setting
M ~@: RX data (Up to 30 Byte) —v
® FA to “FF” are entered after converted to “FF OA” to '“FF | X | X | X | X | X | X | X | X |
OF” automatically. Up to 60 Byte data can be entered in | M |
this case. A A

(DOperating mode setting (3Filter setting
00=Selected VFO

. 01=Unselected VFO
* MY position data

. ® When using the DR function, the transceiver returns “FA”
Command: 23 00 (NG) because these cannot be set to 01.
(00—~ —©-0——@-®— + When VFO As selected
DXEX] e PXEXXEX] e [XEX XX e |X5X|ﬁ 00 = operating mode of VFO A changes

01 = operating mode of VFO B changes
@ — @~ —,— @~ — * When VFO B is selected
|X§X|X§X|X§x|'-'-'- ,,,,,,, IX§X|X§X|--.-- ,,,,,,, |X§x| 00=operat!ng mode of VFO B changes
""""""""" 01 = operating mode of VFO A changes
®~G: Latitude (dd*mm.mmm format) () Operating mode | (@ Data mode @ Filter
® ~ @): Longitude (ddd°mm.mmm format) setting setting setting
@~ ©: Altitude (0.1 meter steps) 00.LSB  |07:CW-R |00: Data mode OFF*? | 01:FIL1
@, @D: Course (1 degree steps) : : : .
~@: Speed (0.1 km/h steps) 01:USB 08:RTTY-R | 01: Data mode ON 02:FIL2
@) ~ @): Date (UTC: yyyymmddHHMMSS) 02:AM 17:DV — 03:FIL3
(y: Year, m: Month, d: Day, 03:CW 22:DD*! — —

H: Hour, M: Minute, S: Second) 04:RTTY |23:ATV* _ _

05:FM - — —

*1 The commands can be set when the 1200 MHz or higher
band is selected.
*2 \When 00 is set, also set 00 to @.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Scope waveform data
Command: 27 00
Outputs the waveform data to the controller.

o 2 @@ ® —0— ® —O0

10503 XXEX]XEX|XEX | [ XXX EX XX XX

@: 00 (Fixed)
(: Order of division data (Current): 01~11
(®: Division number (Maximum): 01(LAN), 11(USB)
® When data is sent to the controller using the [LAN]
port, all data is sent together. However, when the data
is sent through the [USB] port, the data is divided by
11 and sent in sequential order.
® The 1st data sends only the wave information (D
~ ®) without the waveform data (D). The 2nd or
later data sends “00” (D), the order of division data
(Current) (@), the division number (Maximum) (®),
and the waveform data (D).

@: Spectrum scope mode data:
* 00 = Center mode scope
* 01 = Fixed mode scope
* 02 = SCROLL-C mode scope
* 03 = SCROLL-F mode scope

(®: Waveform information:
The waveform information differs, depending on
the Spectrum scope mode.
* In the Center mode:
Center frequency and span are sent.
See page 16 for Operating frequency data,
and the Scope span settings (2 ~ ®).
® When the 5600 MHz or lower band is selected, the
Center frequency is 10 digits (5 bytes).
When the 10 GHz band is selected, the Center
frequency is 12 digits (6 bytes) from 100 GHz to
1 Hz.

* In the Fixed, SCROLL-C, and SCROLL-F modes:

Lower edge and higher edge frequencies are

sent.

See the Scope Fixed edge frequency settings 3

~ (@ on page 29.

® When the Higher Edge or Lower Edge frequency is
in the 10 GHz band, the each Edge frequency is 12
digits (6 bytes) from 100 GHz to 1 Hz.
When the Lower Edge frequency is negative, the
100 GHz digit is set to “F,” and the other than 100

GHz digit are set to absolute value of the frequency.

(®: Out of range information:
* 00 =Inrange
* 01 = Out of range
@ If the scope data is out of range, the waveform data
(@) is omitted.

@: Waveform data:
The transceiver outputs the drawn waveform data.
The data range or data length of the waveform
data is judged by the controller. (The data range is
basically the same as the display size of the scope
on the controller.)
+ Data range: 0 ~ 160
» Data length: 475

* Scope span settings
(in the Center mode and SCROLL-C mode Scope)
Command: 27 15

®© @ ® ® 6 ® Span (kHz)
[0i0]oio|Xxix[xix|xix|0i0] 2500 25
T 1 T Ti 5000, 5
o0 =8 10000| 10
T~ N—N"NLD‘EE
2w /Lo xE 25000 25
CLXqgCs ™ o—~iLo
ScLlsSsSZcoi 50000 50
L 122£252255% 100000| 100
Ty 2o M ANTOT
X XNONIxTINNS 250000 250
iILT_IEIOO_z§§(IDO
So2--ggee e 500000| 500
1000000 | 1000
2500000| 2500
5000000| 5000
10000000 | 10000
25000000 | 25000

» Scope Reference level settings
Command: 27 19

[oio[xx[xi0]0:X]
3 T l T 00= + (plus)
s T S 01=—(minus)
- ©E B

s 25982
T .= mn —~

XXm°@0TT

ir L © m - %

— >~ o ©° < 2

O O «~— +— O O

Adjustable range: —20.0 dB ~ +20.0 dB
in 0.5 dB steps.
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Remote control (CI-V) information

¢ Command formats

» Scope Fixed edge frequency settings
Command: 27 1E

© 2@ e e 6 ® ® ® @ O O ®
[0 x|o:x]xix|xix|x:x[xix x xx: x| x x| x: X[ x x| x x|

] ol gl R ol g RO
o o oL o, o o
O = o | g @ roNL o5l o @ L o N
2 2 rOﬁacl,O’o‘F.?x@llo'olF,?
' 8 oo ao = Lo o0 gi
S g olo_.*=_u 50 Lo & o S
0 o EtoEfio o2 0  EoE5s oS
- 2P L5 PEDEES O uGREDEES
O E ODEDES P09 Do O 0T .22
€ S g og°2NO  CoPEogoND OOy
o c 92O NT NN IS 2o NT NN I
S NONITINNSNONTITINNS
g S INT x=LII=ITNT x=IIT
(o] oo Spo oo Spo
0 5§ ocTIX3838300=203cTxX5800=2095
LI_ LLI\_‘_‘_‘_‘_‘_‘_‘_\_‘_‘_‘_‘_\_‘_\_‘_‘_‘_‘_
Lower edge Higher edge

® Entry of less than 1 kHz digits are ignored.
® When “06” is selected in @, the each Edge frequency is
12 digits (6 bytes) from 100 GHz to 1 Hz.

© 0 ®w6e 6O ® ® OO 2 6 @
[o:6o:x]xix]xx|xexx:x|xix|o:x|x:x[x:x|x:x|x x| X 0:X

o
! 3 3
oz o [}
o o = X
> = P02 E 0%ao T &
Lol V1A o lo, 7y 19d -
8 g0 lolot=C95,07 ol o1=S2g
> gOlooucuoo::”OIO?;O;oo::“
9 S o CiEuE L 1 9DEC L E L L ODE
< 2 = 7 E oy 07-9'5-,-—'0 TOE T B o5 m-g"a-—'c'c.g’
O C DEDFGOoFGOoL2YNOODE G Oo5022y D
=] o ©TOo N NOOT T NT.D5 N NOOTT TN
g T PITNTI NN T YT NINN
0 DN NTTIPPSOINTNTTIPRSOT
S T INIoSoX= coOITINT Sox=2 )
L W oIx¥xE880c0208800TX¥880020880
Nttty A SRR
Lower edge Higher edge

(D Selectable Frequency ranges:

Data | Frequency range (unit: MHz)
01 144.000000 ~  148.000000
02 430.000000 ~  450.000000
03 1240.000000 ~ 1300.000000
04 2300.000000 ~ 2450.000000
05 5650.000000 ~ 5925.000000
06 | 10000.000000 ~ 10500.000000

@ Selectable Edge number: 01=1, 02=2, 03=3, 04=4
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